
    uman evolution is an important and intriguing 
area of biology (Alles & Stevenson, 2003). The significance of 
evolution as a component of biology curricula, at all levels, can 
not be overstated; the need to make the most of opportunities 
to effectively educate students in evolution as a central and 
unifying realm of biology is paramount. Developing engaging 
laboratory or classroom activities that investigate human evo-
lution (e.g., DeSilva, 2004) can therefore be of significant value 
to students and educators.

This report describes an exercise involving comparative 
anatomy of hominid skulls, centering on the use of digital 
imaging to generate measurement data for comparison and 
analysis. Here, hominid refers to the family Hominidea; that is, 
all modern and extinct Great Apes—including humans, chim-
panzees, gorillas, and orangutans. Rather than as a step-by-
step fixed protocol, this laboratory is presented with options 
that emphasize adaptability to various pedagogical approaches 
and instructional levels. Versions of this laboratory have been 
used in college evolution and introductory biology courses; 
adaptations are likely to be of value for other courses, includ-
ing non-majors’ biology, comparative anatomy, and secondary 
school biology.

Features of skulls (commercially obtained skull casts) 
are identified and compared by students in order to develop 
an evolutionary analysis centered on functional anatomy. The 
focus of this exercise is on structural features that relate to 
three characteristics central in human evolutionary history: 
brain size, posture, and mastication. As with other published 
activities designed to explore hominid evolution using skull 
comparisons (Nickels, 1999; Nickels, 1987), various quantita-
tive and qualitative measures are introduced and employed. 
However, this exercise also extends this approach in a novel 
way by employing quantitative craniometric relationships 
made using digital imaging.

This activity can accommodate a variety of approaches to 
investigate specific differences between species, relate struc-
ture and measures to function, and apply observations and 
data to evolutionary paradigms. For example, based on initial 
exposure to skulls and discussion or background reading, 
students can develop and test hypotheses about how particu-
lar measures indicative of braincase size will compare among 
species. 

Interpretations of data collected can be made in light of 
current understanding of the time course and ramifications of 
changes in form and function associated with human evolu-
tion. Aspects of evolution are introduced in a hands-on manner 
in this exercise, which also supports the study of human anato-
my and emphasizes functional and comparative anatomy.

Methods 
As introduction to the exercise, some basic relevant func-

tional anatomy is first reviewed using skull models, illustra-
tions, and select reference materials (e.g., Lewin, 2005; Lewin 
& Foley, 2004; Campbell, 1998). Instructors have, of course, 
a number of options as to how this material is presented and 
integrated, ranging from lecture to assigned reading to more 
hands-on, active learning approaches. Characteristics focused 
on in this introduction reflect major differences among homi-
nids involving: 1) the size of the brain case (and hence the size 
of the brain), 2) muscular and skeletal elements of mastica-
tion, and 3) body posture and support of the head. Emphasis 
is placed on encouraging students to consider interrelations 
between differences in skull structure and characteristics such 
as intelligence, behavior, nutrition, and way of living. Students 
first then develop familiarity with anatomical features (Table 1) 
relating to their comparative analysis.

Skull casts of hominids used in this exercise are avail-
able from a number of specialty suppliers (e.g., Bone Clones®, 
Canoga Park, CA; www.boneclones.com) and general vendors 
(e.g., Ward’s Natural Science, Rochester, NY; www.wardsci.
com). The number of students per lab group can be adapted 

H
J O H N  C . R O B E R T S O N

INVESTIGATING HUMAN EVOLUTION 

Using Digital Imaging & Craniometry

JOHN C. ROBERTSON is Associate Professor, Department of Biology, 
Westminster College, New Wilmington, PA 16172; e-mail: 
robertjc@westminster.edu.

O N L I N E  I N Q U I RY  &  I N V E S T I G AT I O N

DIGITAL IMAGING & CRANIOMETRY      37



based on resources and the specific design 
of the activity. As an example protocol, each 
group works with a total of four specimens 
(skulls), choosing any combination from the 
four groups listed in Table 2. Species listed 
in this exercise are broadly representative 
of hominids; other species can be added or 
substituted.

To facilitate comparison of the different 
species, quantitative and qualitative mea-
sures are made of features on different skulls. 
Examples of quantitative data that students 
are specifically asked to incorporate into 
their comparative analysis include the follow-
ing measures:

• braincase size (in cm3)

• condylar position index (ratio of CD:
CE x 100, see Figures 1 and 2)

• supraorbital height index (ratio of 
FB:AB x 100, see Figures 1 and 2)

• maxillary prognathism index (ratio of 
HE:DE x 100, see Figures 1 and 2)

• angle of forehead (see Figures 1 and 2)

• post-orbital constriction index (as % of skull 
width; see Figure 3)

Students are asked to develop their own model for 
estimating braincase volumes (rulers and measuring tapes 
are provided). To generate the other quantitative measures 
listed, students take digital images (typically JPEG files) of 
skull casts using standard digital cameras 
of at least 1 megapixel resolution. Quality 
images are effectively obtained with the 
casts placed on a table-top under ambi-
ent room lighting. Appropriate software 
(e.g., PowerPoint) is then used to overlay 
lines and points in specific anatomical 
locations on the skull images. Details of 
digital imaging, image manipulation, and 
instructions for placement of lines and 
points for craniometry are provided to 
students (Figures 1 and 2). By measur-
ing (directly on the computer screen 
or using a ruler on printouts) length of 
specific line segments and calculating 
ratios, students generate craniometric 
data. Note that because the ratio data 
have no units, relative magnification of 
the skulls in individual images need not 
be standardized. Forehead slope is mea-
sured using a protractor. 

These quantitative data provide indi-
cations of anatomical adaptations relating 
to shifts in brain size, posture, and diet 
over hominid evolutionary history (Table 
3). Thus — in addition to students’ direct 
estimate of braincase volume — increased 
supraorbital height index, lower post-
orbital constriction index and decreased 
angle of the forehead all correlate with 
greater cranial capacity. Increased condy-

lar position index indicates both a shift 
in position of the spine associated with 
evolving bipedalism as well as expan-
sion of the posterior skull. Decreased 
maxillary prognathism indices indicate a 
reduction in the relative size of the masti-
catory components of the skull. 

In terms of qualitative analysis, there 
are numerous interspecific comparisons 
that students can make and relate to 
functional anatomy. For example, the 
angle of the foramen magnum can be 
assessed; this opening tends to be flat 
in a biped and elevated in a quadru-
ped. Access to additional, non-hominid 
quadruped skulls (e.g., cat or deer) for 
comparison can help illustrate this point 
for students. The presence and relative 
size of a sagittal crest can be evalu-
ated; this attachment site can provide an 
indication of the size and action of the 
temporalis muscle in chewing. The rela-
tive size of the zygomatic arch opening 
can also indicate size of the temporalis 
muscle that passes through this open-
ing to insert on the mandible. In part, 
more pronounced brow-ridges help dis-
sipate forces associated with chewing; 
reduction in the size of the supraorbital 

38      THE AMERICAN BIOLOGY TEACHER, ONLINE PUBLICATION,  MARCH 2007

Table 1. Features useful for students to become familiar with in a functional anatomy-
based comparative analysis of hominid skulls. 

F E AT U R E CO M M O N  M E A N I N G
Neurocranium Braincase or cranial cavity
Orbits Eye sockets
Supraorbital torus Brow ridges
Post-orbital constriction Indentations in lateral skull behind orbits
Forehead slope Angle of the forehead (not brow ridges)
Zygomatic arch Cheek bones
Sagittal crest Ridge of bone along medial skull
Prognathism Anterior extension of jaws from skull and face 
Foramen magnum Large opening in skull underside for spinal cord
Occipital condyles Bony protuberances lateral to foramen magnum

Temporalis muscle
Chewing muscle; origin on lateral skull, insertion on mandible, 
runs through the zygomatic arch

Temporalis line Marking on lateral skull at attachment site of temporalis muscle 
Masseter muscle Chewing muscle; origin on zygomatic arch, insertion on mandible
Dental arcade Line formed by teeth in the upper and lower jaws

Table 2.  Specimens included in hominid skull evolutionary analysis. 
Students typically analyze four skulls, selecting one from each of the four 
groups listed. 

Group 1 Gorilla gorilla (Gorilla) Pan troglodytes (Chimp)
Group 2 Australopithecus afarensis (“Lucy”) Australopithecus boisei
Group 3 Homo habilis Homo erectus
Group 4 Homo neanderthalensis Homo sapiens

Figure 1.  Schematic provided to students as a 
guide for placement of lines and points used to 
obtain craniometric data. Horizontal line DE runs 
from the posterior most point of the skull to the 
anterior extent of the maxilla at the level of the 
bottom margin of the orbit. Vertical line AB runs 
from the superior-most point of the skull to line 
DE. Line F extends horizontally from the top of 
the orbit posterior to line AB. Line C runs vertical-
ly up from the center of the occipital condyle to 
line DE. Line H originates perpendicular to line DE 
at the anterior orbit and extends up beyond the 
top of the skull. Angle J is formed by line H and 
an intersecting line that follows the forehead 
slope (not the brow ridge). See text for descrip-
tion of calculating various craniometric indices. 



torus thus generally correlates with 
reduction in other skull masticatory 
structures. Also relating to diet, a 
number of measures involving the 
teeth can be made – including the 
molar occlusal surface area, dental 
formula, and the shape and relative 
size of the dental arcade (Arsuaga & 
Martínez, 2006; Campbell, 1998).

Analysis
Students’ analysis of data can 

take a variety of forms. For example, 
one simple exercise is to have stu-
dents identify and label important 
anatomical features in various imag-
es (i.e., lateral, superior and inferior, 
anterior and posterior views) of the 
skulls. They may be asked to sum-
marize how each of the character-
istics evaluated relates to brain case 
size, the masticatory apparatus, and 
posture – thereby proposing func-
tional significance for the various 
features that they have examined. 
In fact, students can be asked at 
the start of the exercise to hypoth-
esize as to what the various cranio-
metric indices and other features 
“mean” anatomically and function-
ally; they can then evaluate their 
ideas by applying collected data and 
resource materials. Interpretations 
can also be drawn regarding the adaptive implications changes 
in these parameters would have for the organisms. 

Typically, students are asked to use information on fossil 
ages available in biology textbooks and other references (e.g., 
Lewin, 2005; listed Internet Resources) to place the species 
(excluding the extant apes) they chose to work with in a 
chronological history of hominid evolution. They can then 
use this chronology as a basis to think about and analyze 
their data. To help focus their analysis, specific questions that 
might be posed to students include which characteristics show 
the greatest differences between species, if all the features 
examined evolve together, and if the traits evolve at consistent 
incremental rates over time.

In the evolution course, students have been asked to 
consider how each relevant quantitative measure relates to 
brain case size (i.e., positively or negatively correlated, relative 
significance of the measure) and to construct a mathematical 
index (formula) that relates these fea-
tures to cranial capacity. They then apply 
their own skull data to their abstract cra-
nial capacity formula, and must compare 
results with what is known about the 
relative ages and phylogenetic relation of 
the specimens examined. Based on this 
analysis, they critique their indices as a 
system for understanding the evolution-
ary history of hominids.

Another more advanced approach is to 
ask students to develop, describe, and apply 
one or more of their own quantitative cra-
niometric measures to explore structural and 
functional shifts associated with hominid evo-
lution. Such an activity is readily amenable to 
inquiry-based or hypothesis testing approach-
es. There is clearly a wealth of craniometric 
measures that can be identified and explored; 
those few illustrated in the activity described 

here include standard measures (e.g., condylar position index) 
and some developed for the activity (i.e., maxillary prog-
nathism index). The physical anthropology literature (e.g., 
Whitehead et al., 2005) provides a rich resource for instructors 
interested in identifying or developing additional quantitative 
craniometric measures. 

As hominid evolution is currently a very active research 
area, information literacy activities can also be readily inte-
grated into the exercise. In addition to older reports, recent 
work describing newly discovered hominid fossils (e.g., Brown 
et al., 2004; White et al., 2003; Leakey et al., 2001), new tech-
niques for comparative analyses (e.g., Zollikofer et al., 2005), 
and molecular phylogenetic contributions to current views of 
hominid relationships (e.g., Wildman et al., 2003) all could 
serve as related entry points leading students into the pri-
mary literature in this field. Values for some of the measures 
described here — or related data — are available in the literature 
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Figure 2. Examples of hominid skull images 
with overlaid lines and points for craniometric 
measures. Top: Australopithecus afarensis. 
Bottom: Homo sapiens. Tape near point C on 
both skulls is a reference mark for the location of 
the occipital condyle. For consistent orientation 
of skulls for imaging and placement of lines, the 
maxillary dentition should lie horizontally; this 
requires elevation of the posterior skull of some 
specimens, as seen here with A. afarensis. 

Figure 3. Illustration of calculation of the post-orbital 
constriction index. The more vertical lines follow the 
lateral contours of the braincase forward to the lateral 
orbit margins. Post-orbital constriction can be calculated 
by dividing the length of line Y by the length of line X. 
This value is then subtracted from 1.0 and the result 
multiplied by 100 to yield the index as a percent con-
striction of the skull width. Left: Pan troglodytes. Post-
orbital constriction index is 31%. Right: Homo erectus. 
Index is 19%. 

Table 3. Examples of some craniometric data collected from analysis of four skulls. Note that 
index data have no units – they are ratios of measures of line lengths made using skull images.

P. troglodytes A. afarensis H. erectus H. sapiens
Condylar Position Index 12 36 50 61
Supraorbital Height Index 41 47 61 58
Maxillary Prognathism Index 27 21 11 11
Angel of Forehead 47 ˚ 65 ˚ 48 ˚ 28 ˚



(e.g., Campbell, 1998). These values 
might be provided or students may be 
expected to search for such relevant 
information as part of the exercise. 

Moreover, a variety of media 
resources (e.g., videos such as Films 
for the Humanities & Sciences’, 
“Challenging the Human Evolution 
Model,” and the Nova production, “In 
Search of Human Origins, Episode 
1: The Story of Lucy”) and popular 
science literature (e.g., Wong, 2005; 
Zimmer, 2003; Gould, 1979) can 
be used in support of or integrat-
ed with the described exercise. “The 
Mismeasure of Man” (Gould, 1996) 
provides particularly interesting and 
relevant insights into the history of 
science and use of dubious craniomet-
ric data in advancing a deterministic 
social agenda. 

Application
Experience indicates that stu-

dents have few problems with techni-
cal aspects (imaging and image pro-
cessing) of this activity. The expense 
of skull casts is significant but not 
prohibitive; the author has found indi-
vidual casts available at costs rang-
ing from about $100 to about $300, 
depending on the species, producer, 
and vendor. Defined study sets of skull casts are also available, 
usually at some discount over individually purchased casts. 

Digital cameras for this exercise are another resource to 
be considered. Depending on specifics of the assignment, 
there may not be need for each group to take a large number 
of images – in which case one or two cameras could suffice for 
even a large class. Cameras capable of capturing images of only 
1 megapixel have been used very successfully for the activity. 
Presently, higher resolution digital cameras — taking at least 3 
megapixel images — can be purchased for under $100. Images 
are initially captured as data files (e.g., JPEG) to the camera’s 
internal memory or an optional flash memory card (e.g., 
SmartMedia or MemoryStick), and can then be downloaded 
to a computer. For those less familiar with digital imaging, a 
variety of helpful print (Miotke, 2005) and Internet Resources 
(e.g., Curtain, 2006) are available. For adding lines and labels 
to the images, a variety of software programs can be used; basic 
instructions for image processing in PowerPoint are provided 
in Table 4. 

With many images of hominid skulls readily available 
in the literature and online (see Internet Resources below), 
some aspects of this exercise could be done strictly as an 
image-based activity. However, the hands-on tactile and true 
three-dimensional advantages make the use of skull casts an 
excellent learning experience. Additionally, digitizing software 
programs — a number of which are freely available for down-
load, including Image J from the National Institutes of Health 

(available online at: http://rsb.info.nih.gov/ij/) — could be inte-
grated into this lab to directly generate length, area, and angle 
measures from skull images. 

The activity described is highly malleable; depending on 
the audience and the amount of time available, additional 
depth of material or activities can be included or the focus and 
scope can be restricted. Time invested in establishing appro-
priate specific outcomes and developing a clear and concise 
introduction and protocol should contribute to the success of 
the experience. 

Based on anecdotal feedback and discussions, students 
react positively to the exercise. They seem to appreciate the 
opportunity to work hands-on with skull casts and to enjoy 
the imaging and collection of quantitative data. Learning about 
skulls appeals to many students’ interest in human anatomy; 
many are also quite curious about evidence for and current 
ideas concerning human evolution. In sum, this comparative 
activity is an effective and engaging introduction to human 
evolution that draws together elements of several sub-fields of 
biology and other disciplines (e.g., anthropology). 

Internet Resources
• ArchaeologyInfo.com Site: http://www.archaeologyinfo.

com/index.html.

• Becoming Human Site. Institute of Human Origins, 
Arizona State University. http://www.becominghuman.
org/.

Table 4. Basic instructions for moving images into PowerPoint and adding lines and labels.

1. Open a new blank presentation in PowerPoint.
2. Under the Format menu, select Slide Layout. Choose a blank slide layout.
3. Under the Insert menu, select Picture and From File.
4. Browse to the appropriate location of the file. Select (click and highlight) the image you wish to 

insert, then click the Insert button.
5. If a resolution box appears, choose the default resolution (768 X 512 pixels).
6. Your image will be placed in the PowerPoint slide.
7. You can resize your image by clicking and dragging on any corner (resizing from any side will 

distort the image and may introduce artifacts into the craniometric measures). 
8. Under the PowerPoint View menu bar, select Toolbars, then select Picture. A Picture Toolbar 

appears that allows you to do some manipulation of the image, including adjusting the bright-
ness and contrast.

9. Under the PowerPoint View menu bar, select Toolbars, then select Drawing. A Drawing Toolbar 
appears that allows you to do add lines and labels to your image. 

10. When finished labeling the image, under the Edit menu choose Select All. This will highlight the 
image and all the labeling that you have added.

11. Place the mouse cursor anywhere on the image and right-click once. A box will appear.  Select 
Grouping and then choose Group. This will fuse your labels to the image. If you do not do this, 
the labels will move if you move or resize the image at a later time.

12. Save the image as:
a. JPEG file interchange format 
b. Presentation file

13. To add additional images to the same presentation file, under the Insert menu choose New 
Slide and repeat the above steps. In this case, you will end up with a single .ppt presentation file 
containing all manipulated images as individual slide pages. Alternatively, you can save images as 
separate .jpg image files (1 per image). 

40      THE AMERICAN BIOLOGY TEACHER, ONLINE PUBLICATION,  MARCH 2007



• Human Origins Program Site. Smithsonian Institution. 
http://www.mnh.si.edu/anthro/humanorigins/index.
htm.

• Online Human Evolution 3-D Gallery. University of 
California at Santa Barbara. http://www.anth.ucsb.edu/
projects/human/.

• Prehistoric Life Site. BBC. http://www.bbc.co.uk/sn/pre-
historic_life/human/.
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